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Chapter 1

eAssistant/TBK 3D CAD Plugin for
SOLIDWORKS

1.1 Installation

Please start the installation �le and follow the instructions. The CAD plugin will be installed on your system.
Select `eAssistant' or `TBK' during installation depending on the product. Once the CAD plugin is installed,
start SOLIDWORKS and open a new part. The Tools drop-down menu in the SOLIDWORKS menu bar
provides the entry `eAssistant' or `TBK'.

Figure 1.1: Installation

Please Note: In case the CAD plugin is not visible in the SOLIDWORKS Tools drop-down menu, you must
enable the eAssistant/TBK add-in application. Click `Tools ⇒ Add-Ins' from the SOLIDWORKS menu bar
and activate the eAssistant/TBK application.

1.2 Start

Click the Tools drop-down menu to use all functions of the CAD plugin in SOLIDWORKS.

Figure 1.2: Start
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1.3 Program Scope

Currently, the following features can be created in SOLIDWORKS based on the calculated eAssistant/TBK
data:

- External and internal cylindrical and helical gears

- Rack/pinion gear pairs

- Straight, helical and spiral bevel gears

- Serrated shafts, splined shaft connections (shaft/hub)

- Solid and hollow shafts with an unlimited number of cylindrical and conical shaft segments

- Involute splines (shaft/hub)

as well:

- Saving of calculation data in the 3D model

- Placing manufacturing data of cylindrical gears, bevel gears and involute splines on the manufacturing
drawing

- Cylindrical gears and involute splines can be created directly on an existing part.

- Bidirectional connection between eAssistant/TBK and SOLIDWORKS (shaft, gear, involute spline pro�le
as single design component) (from SOLIDWORKS 2008)

- Accuracy/point distance for the tooth form can be de�ned in the options menu.

- Tooth �anks as splines or alternatively as arcs for cylindrical gears and involute tooth pro�les possible

1.4 Menu

1.4.1 Calculation

Once the CAD plugin is started, all eAssistant/TBK calculation modules can be opened directly through the
`Calculation' menu in SOLIDWORKS.

Figure 1.3: Calculation

www.eAssistant.eu
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Note on eAssistant: Please note that you need an eAssistant username and password to start the calcula-
tion modules through the `Calculation' menu (see `User data'). Only the free-of-charge modules can be used
without the eAssistant access data.

1.4.2 New Part

Based on the eAssistant/TBK calculation, the parts can be created directly in SOLIDWORKS by clicking the
menu item `New part'.

Figure 1.4: New part

Complete a calculation using the eAssistant/TBK. Click on the button `CAD ⇒ SOLIDWORKS output' in
the top menu bar of the eAssistant/TBK. Con�rm the message `Data for CAD was written successfully.' with
the button `OK'.

Figure 1.5: SOLIDWORKS Export

Please Note: During the generation of involute gearings (cylindrical gears, single cylindrical gears, gear racks,
involute splines), we recommend to select the mean tooth thickness allowances and the mean tip diameter
allowances. The CAD model is then created with these allowances. You can modify the allowances by opening
the mask `Tooth form' in the respective gear modules.

Figure 1.6: Mean tooth thickness and tip diameter allowances

www.eAssistant.eu
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Then click the menu item `New part' in the CAD plugin and select the corresponding element. Now the 3D
model is created.

1.4.3 User Data (applies only for eAssistant)

Click on the menu item `Tools ⇒ eAssistant ⇒ Settings ⇒ User data' to enter your eAssistant username and
your password. You need an account to use all eAssistant calculation modules.

Figure 1.7: User data

In case you do not have an eAssistant account, please visit our web site www.eAssistant.eu to register for a
free test account. Click on the button `Request access data' to get to the eAssistant web site as well. The
account provides a time credit of �ve hours to test the eAssistant without any charges or obligation. Are the
�ve hours expired, the test account is deactivated automatically. If you want continue to use the eAssistant,
you need to purchase an account. Decide between hour packages or �at rates.

Figure 1.8: Access data

As soon as you entered your username and password into the window, you can start all eAssistant calculation
modules directly through the menu item `Tools ⇒ eAssistant ⇒ Calculation' without logging in again. The
eAssistant and SOLIDWORKS will be connected automatically.

www.eAssistant.eu
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Please Note: Activate the option `Save data permanent' to save your username and password and to open
all calculation modules immediately without entering username and password again.

Figure 1.9: Save access data

1.4.4 Options

Click the menu item `Tools ⇒ eAssistant (TBK) ⇒ Settings ⇒ Options' to adjust di�erent settings for
cylindrical and bevel gears. Select spline or arcs (tangential) to connect the points.

Figure 1.10: Options

You can, for example, de�ne the distance between the points (accuracy) or the number of teeth to be generated.
Just activate the checkbox and enter the appropriate number of teeth.

Figure 1.11: Accuracies

www.eAssistant.eu
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1.4.5 Language

Click the menu item `Tools ⇒ eAssistant (TBK) ⇒ Settings ⇒ Language' in order to change the language.
German and English are available. Restart SOLIDWORKS or the CAD plugin (by clicking Tools Add-Ins ). The
menu interface of the CAD plugin adapts itself automatically to the selected language. The eAssistant/TBK
calculation modules are started in the selected language as well.

Figure 1.12: Language

1.4.6 Help

Click on the menu item `Tools ⇒ eAssistant (TBK) ⇒ Help ⇒ eAssistant (TBK)' help online to open the
eAssistant/TBK manual where you can �nd additional information on the eAssistant/TBK.

Figure 1.13: Help

www.eAssistant.eu
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1.5 Create a Shaft

Based on the eAssistant/TBK calculation, shafts with an unlimited number of cylindrical and conical seg-
ments can be created as a 3D part. Click on the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation ⇒
Shaft' to start the eAssistant/TBK module. Then make a shaft calculation. Click on the button `CAD ⇒
SOLIDWORKS export' in the eAssistant/TBK module.

Create the shaft in SOLIDWORKS by clicking on the menu item `Tools ⇒ eAssistant/TBK ⇒ New part ⇒
Shaft'.

Figure 1.14: Create a shaft

Please Note: You can also create a 2D sketch of a shaft in SOLIDWORKS and then import it to eAssis-
tant/TBK. Please see Section 1.12 for more information.

1.6 Create a Cylindrical Gear

Click on the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation ⇒ Gears ⇒ Cylindrical gear pair' in order
to start the eAssistant/TBK calculation module. Then make a calculation. Click on the button `CAD ⇒
SOLIDWORKS export' in the eAssistant/TBK module.

Click on the menu item `Tools ⇒ eAssistant (TBK) ⇒ New part ⇒ Cylindrical gears ⇒ Cylindrical gear 1'
or cylindrical gear 2, 3, 4 to create the cylindrical gear in SOLIDWORKS.

Figure 1.15: Create a cylindrical gear

www.eAssistant.eu
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1.7 Create a Gearing on an Existing Part

The eAssistant/TBK plugin provides a simple way to create a gearing directly on an existing part (pinion
shaft).

Figure 1.16: Existing part

Make a gear calculation in the eAssistant/TBK. Click on the button `CAD ⇒ SOLIDWORKS export'. Select
a front face where you want to place the gearing. The face will then be highlighted. Select the menu item
`Tools ⇒ eAssistant/TBK ⇒ New part ⇒ Cylindrical gears ⇒ Cylindrical gear 1' to add the gearing to the
existing part.

Figure 1.17: Gearing on existing part

When the dialog window for the `Runout con�guration' appears, con�rm with the `OK' button. Please note
that the tip circle diameter of the cylindrical gear and the diameter of the selected shaft segment must have
the same size!

www.eAssistant.eu
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1.8 Add Manufacturing Data to Engineering Drawing

With just one click, the design table with all manufacturing details can be placed on the manufacturing drawing.
Open a drawing in SOLIDWORKS. Select the menu item `Tools ⇒ Assistant (TBK) ⇒ Manufacturing data
⇒ from selected view or from current calculation ⇒ Cylindrical gear 1' to create the table.

Figure 1.18: Add manufacturing data to the drawing

After installation of the CAD plugin, the �le `Manufacturingdata.xml' appears in the program directory.
When calling the manufacturing data via the CAD plugin, a new folder is created in the Windows direc-
tory C:\User\[Username]\AppData\Roaming. Various templates (for example `ManufacturingdataBG.xml')
for the design tables are saved in this folder and only these XML �les are used to con�gure the table. Based
on these �les, the design table can be modi�ed to your preferences.

Cylindrical gears, bevel gears and involute splines get a template as soon as you call the manufacturing data.
For bevel gears, a distinction is made between straight/helical bevel gears and spiral bevel gears. The appear-
ance and size of that table are both individually con�gurable.

Open the XML �le with a text editor and change the corresponding rows, for example from `visible=true' into
`visible=false' to show or hide speci�c table rows. Sort rows with cut and paste, mix numeric values and text
or add an image.

Save the XML �le and place it to the manufacturing drawing.

Figure 1.19: XML �le

www.eAssistant.eu
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In case you need more extensive customizations (font size, column width, etc.) of the table, please contact
our support team.

Basically the table with manufacturing data can be adapted to your individual requirements. Whether any
number of columns or additional information and illustrations, such as a logo, the formatting options are very
diverse and �exible. Here is an example of how the manufacturing table could look like:

Figure 1.20: Table with manufacturing data

1.8.1 Create User-de�ned Templates

You can create your own templates for the manufacturing data, which can then be conveniently selected from
a listbox as soon as you want to place the manufacturing data on the drawing. You can create a completely
new template or use an existing template (for example, `Manufacturingdata.xml') as a basis and add entries.

Please Note: When creating the user-de�ned template, this new template must be located in the C:\User\
[Username]\AppData\Roaming\eAssistant directory.

Open the XML �le in a text editor, change the document according to your needs. Give the �le a new name.
In the following example, the �le is named as `ManufacturingdataNewTemplate'. Save the �le again as XML
�le and close it.

Now open the �le `eAssistantXML.xml' from the directory C:\User\[Username]\AppData\Roaming\eAssistant.
Here the �le you saved before (`ManufacturingdataNewTemplate') must be included.

www.eAssistant.eu
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The example is manufacturing data for cylindrical gears, so the new template is created under `Gear'. Under
`Filename' you enter `ManufacturingdataNewTemplate', under `langKey' you de�ne the name to be displayed
in the listbox (`This is a new template').

Figure 1.21: New template

Restart SOLIDWORKS. If you now place the manufacturing data of a cylindrical gear on the drawing, �rst
the listbox is displayed. Here you can then select the corresponding template. If you activate `Do not display
this dialog again', the standard �le will be opened automatically.

Figure 1.22: Selection of the new template

Please Note: If you delete the folder `eAssistant' in the user directory, the templates (XML �les) will be
deleted, too. To avoid this, please create a backup of the folder.

In case the path C:\User\[Username]\AppData\Roaming is not displayed, you need to adjust the folder op-
tions. Open the folder options by clicking `Start ⇒ Control panel ⇒ Folder options'.

Click the View tab. Select `Show hidden �les, folders, and drives' under `Hidden �les and folders'. Click `OK'
to save the new setting.

Please note: The adjustments to the XML �les are not taken over when updating the CAD plugin. All
changes due to updates have to be updated manually.

www.eAssistant.eu
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1.9 Open a Calculation of an Active Part

The calculation information is saved in the 3D model. The calculation, which belongs to the 3D model, can be
opened at any time throughout the entire design phase. If a component contains several di�erent calculation
elements, it is possible to open the corresponding calculations.

To start the calculation, which belongs to the opened 3D model, click on the menu item `Tools ⇒ eAssistant
(TBK) ⇒ Calculation' and select the corresponding calculation module. The following dialog window appears.

Click the `Yes' button and the eAssistant/TBK opens the calculation module with all calculation values.

Figure 1.23: Open the calculation

Even if there are several di�erent gear calculations in one 3D model, you can open every calculation �le
again. For the gear, for example, click on the feature tree on the left side in SOLIDWORKS to select the
corresponding cutout. Click on the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation' and then click on
the calculation module.

1.10 Add a Tool Runout to the 3D Model

For pinion shafts you can add a tool runout to the 3D model. For this purpose, you have to specify a cutter
radius. Select the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation ⇒ Gears ⇒ Cylindrical gear pair'
and run a cylindrical gear calculation.

Click the button `CAD ⇒ SOLIDWORKS export'. Choose a plane of the shaft in SOLIDWORKS and click
the menu item `Tools ⇒ eAssistant (TBK) ⇒ New part ⇒ Cylindrical gears ⇒ Cylindrical gear 1'.

www.eAssistant.eu
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The dialog window is opened. Activate the option `Yes' for `Run-out at start' or `Run-out at end'. Add a
cutter radius and con�rm with `OK'.

Figure 1.24: Runout

Now you can check if the tool runout collides with the following shaft segment, so that you can correct it. If
necessary, you can add a straight element by using the option `O�set'.

1.11 Bidirectional Connection between eAssistant/TBK and SOLID-
WORKS

The attractiveness of the CAD plugin is additionally enhanced by the bidirectional connection between eAssis-
tant/TBK and SOLIDWORKS. As changes are made to a calculation, the 3D model can be updated (shafts,
cylindrical gear or involute spline pro�le/hub pro�le as single part).

Select the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation ⇒ Gears ⇒ Cylindrical gear pair' and make
a cylindrical gear calculation.

Click the button `CAD ⇒ SOLIDWORKS export' to transfer the calculation values to SOLIDWORKS.

Click the SOLIDWORKS menu item `Tools⇒ eAssistant (TBK)⇒ New part⇒ Cylindrical gears⇒ Cylindrical
gear 1' to create the cylindrical gear.

Figure 1.25: Create a gear

www.eAssistant.eu
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To make necessary changes on the CAD model, re-open the eAssistant/TBK module and modify the calcu-
lation. Because the calculation information is saved to the CAD model, you can start the eAssistant/TBK
calculation by clicking `Tools ⇒ eAssistant ⇒ Calculation ⇒ Gears ⇒ Cylindrical gear pair'.

Con�rm the following message `Shall the calculation of the active part be loaded?' with the button `Yes' and
the related calculation module starts. For example, you can add a hole to gear 1. Click on the button `CAD
⇒ SOLIDWORKS export'.

Figure 1.26: Add a hole

Select the item `Extrusion2' from the integrated SOLIDWORKS feature tree. The area between the teeth will
then be highlighted.

Figure 1.27: Select the area

www.eAssistant.eu
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Select `Tools ⇒ eAssistant (TBK) ⇒ New part ⇒ Cylindrical gears ⇒ Cylindrical gear 1' and the message
`Should the component be adjusted to the current calculation?' appears.

Figure 1.28: Adjust to the current calculation

Click the `Yes' button and the CAD model is updated immediately and quickly adjusted to the current
calculation.

Figure 1.29: CAD model

www.eAssistant.eu
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1.12 Create a Shaft in SOLIDWORKS and Import it into eAssis-
tant/TBK

You can create a shaft directly in SOLIDWORKS and then import it into eAssistant/TBK. Solid and hollow
shafts with cylindrical and conical shaft segments are possible. To create a shaft as a revolved part, use the
CAD´s revolve features, the inner shaft geometry can be generated using the revolved cut feature.

Figure 1.30: Shaft geometry

To create a shaft as a revolved part, use the SOLIDWORKS Revolve Feature.

Select the corresponding feature(s) from the FeatureManager design tree and import the shaft into eAssis-
tant/TBK by clicking the menu item `Tools ⇒ eAssistant (TBK) ⇒ Calculation ⇒ Shafts'.

Figure 1.31: Calculation of the shaft

www.eAssistant.eu
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The eAssistant/TBK shaft module opens and the shaft is loaded into the calculation module.

Figure 1.32: Shaft in eAssistant/TBK

www.eAssistant.eu
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